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Manage Circuits

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter explains how to manage Cisco ONS 15454 electrical, optical (OC-N), Ethernet, and virtual 
concatenated (VCAT) circuits. For information on SDH tunneling, refer to the “SDH Tunneling Over 
Cisco ONS 15454 SONET MSPP Systems” Application Note.

Before You Begin
To create circuits, see Chapter 6, “Create Circuits and VT Tunnels.”

To clear any alarm or trouble conditions, refer to the Cisco ONS 15454 Troubleshooting Guide.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-A329 Locate and View Circuits, page 7-2—Complete as needed.

2. NTP-A200 View Cross-Connect Card Resource Usage, page 7-3—Complete as needed.

3. NTP-A151 Modify and Delete Circuits, page 7-4—Complete as needed to edit a circuit name; 
change the active and standby colors of spans; change signal fail (SF) and signal degrade (SD) 
thresholds, reversion time, and path payload defect indication (PDI-P) settings for path protection 
circuits; or add or delete a VCAT member.

4. NTP-A278 Modify and Delete Overhead Circuits and Server Trails, page 7-5—Complete as needed 
to change a tunnel type, repair an IP circuit, or delete overhead circuits.

5. NTP-A78 Create a Monitor Circuit, page 7-5—Complete as needed to monitor traffic on primary 
bidirectional circuits.

6. NTP-A328 Create a J0 Section Trace, page 7-7—Complete as needed to monitor interruptions or 
changes to circuit traffic.

7. NTP-A79 Create a J1 Path Trace, page 7-8—Complete as needed to monitor interruptions or 
changes to circuit traffic.

8. NTP-A293 Create a J2 Path Trace, page 7-9—Complete as needed to monitor interruptions or 
changes to circuit traffic.
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9. NTP-A334 Bridge and Roll Traffic, page 7-11—Complete as needed to bridge and roll traffic.

10. NTP-A298 Reconfigure Circuits, page 7-12—Complete as needed to reconfigure circuits.

11. NTP-A301 Merge Circuits, page 7-13—Complete as needed to merge circuits.

12. NTP-A325 Manage VLANs, page 7-13—Complete as needed to view, create, or delete VLANs.

13. NTP-A348 Display IEEE 802.17 RPR Circuits, page 7-14—Complete as needed to view a map or 
list of IEEE 802.17 RPR circuits between ML-Series cards.

NTP-A329 Locate and View Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at a node on the network where you want 
to view the circuits. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 As needed, complete the “DLP-A416 View Circuit Information” task on page 21-2.

Step 3 As needed, complete the “DLP-A131 Search for Circuits” task on page 18-14.

Step 4 As needed, complete the “DLP-A262 Filter the Display of Circuits” task on page 19-42.

Step 5 As needed, complete the “DLP-A229 View Circuits on a Span” task on page 19-18.

Step 6 As needed, complete the “DLP-A454 View the BLSR STS Squelch Table” task on page 21-34.

Step 7 As needed, complete the “DLP-A455 View the BLSR VT Squelch Table” task on page 21-35.

Step 8 As needed, complete the “DLP-A430 View Spanning Tree Information” task on page 21-9.

Step 9 As needed, complete the “DLP-A532 Export CTC Data” section on page 22-32.

Stop. You have completed this procedure.

Purpose This procedure allows you to locate and view circuits and spanning tree 
information. You can also export circuit data from the Circuits and Edit 
Circuits windows.

Tools/Equipment None

Prerequisite Procedures Circuit creation procedure(s) in Chapter 6, “Create Circuits and VT 
Tunnels” 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-A200 View Cross-Connect Card Resource Usage

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at the node where you want to view the 
cross-connect card resource usage. If you are already logged in, continue with Step 2.

Step 2 Click the Maintenance > Cross-Connect > Resource Usage tabs.

Step 3 In the Summary area of the Resources Usage tab, view the following information:

• STS-1 Matrix—Provides the percent of cross-connect card STS-1 path resources that are in use. 
288 STS-1 paths are available for XCVT cards; 1152 STS-1 paths are available for XC10G and 
XC-VXC-10G cards.

• VT Matrix Ports—Provides the percent of cross-connect card VT matrix ports that are in use. Each 
port is one STS in size, and each can transport 28 VT1.5s or 21 VT2s. 24 VT matrix ports are 
available for the XCVT and XC10G cards. 96 VT matrix ports are available for the XC-VXC-10G 
cards.

• VT Matrix—Provides the percent of VT matrix resources that are in use. 672 are available for the 
XCVT and XC10G cards. (672 is the number of VT matrix ports [24] multiplied by the number of 
VT1.5s in an STS [28].) The VT matrix on the XC-VXC-10G has capacity for 2688 VT1.5 
terminations (1344 VT1.5 bidirectional circuits) or 2016 VT2 terminations (1008 VT2 bidirectional 
circuits). 

Step 4 In the VT Matrix Port Detail section, you can view details of the VT Matrix Port usage:

• Drop—Identifies the source slot, port, and STS.

• Tunnel Name—Displays the tunnel name if the port is used by a VT tunnel. VT tunnels use VT 
matrix ports on the tunnel source and destination nodes. (VT tunnels do not use matrix resources on 
pass-through nodes.) 

• % Used—Shows the percent of the matrix port that are in use. For example, each matrix port can 
carry 28 VT1.5s; if one STS carries seven VT1.5 circuits, the matrix port will be 25 percent used.

• Usage—Shows the port usage. For example, if one STS carries seven VT1.5 circuits, the matrix port 
will show that 7 of 28 VT1.5 circuits are in use.

Step 5 As needed, you can perform the following actions:

• Click the Refresh button to see an updated XC Resources view. For example, if other users create 
circuits while you view the XC Resources tab, click Refresh to see the effects those circuits have 
on the VT matrix usage.

• Click the Delete button to delete STSs that use VT matrix resources but no longer carry VT circuits. 
This occasionally occurs when many VT circuits are added and deleted over a period of time. 
Stranded STSs appear as STSs with 0 percent usage in the VT Matrix Port Detail area. If stranded 
STSs appear, click the STS, then click Delete to free VT matrix capacity.

Purpose This procedure allows you to view the percentage of cross-connect card 
resources used by circuits that traverse or terminate at an ONS 15454. 

Tools/Equipment XCVT, XC10G, or XC-VXC-10G cards must be installed.

Prerequisite Procedures DLP-A37 Install the XCVT, XC10G, or XC-VXC-10G Cards, page 17-42

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note The Delete button requires a Superuser security level.

Note VT tunnels might appear as STSs with 0 percent capacity used. These cannot be deleted. 

Stop. You have completed this procedure.

NTP-A151 Modify and Delete Circuits 

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at a node containing the circuit that you 
want to modify. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-A230 Change a Circuit Service State” task on page 19-19.

Step 3 As needed, complete the “DLP-A231 Edit a Circuit Name” task on page 19-20.

Step 4 As needed, complete the “DLP-A232 Change Active and Standby Span Color” task on page 19-21.

Step 5 As needed, complete the “DLP-A233 Edit Path Protection Circuit Path Selectors” task on page 19-22.

Step 6 As needed, complete the “DLP-A263 Edit Path Protection Dual-Ring Interconnect Circuit Hold-Off 
Timer” task on page 19-44.

Step 7 As needed, complete the “DLP-A333 Delete Circuits” task on page 20-21.

Step 8 As needed, complete the “DLP-A437 Change a VCAT Member Service State” task on page 21-15.

Step 9 As needed, complete the “DLP-A384 Add a Member to a VCAT Circuit” task on page 20-79.

Step 10 As needed, complete the “DLP-A385 Delete a Member from a VCAT Circuit” task on page 20-83.

Stop. You have completed this procedure.

Purpose This procedure modifies and deletes ONS 15454 circuits and tunnels.

Tools/Equipment None

Prerequisite Procedures Circuits must exist on the network. See Chapter 6, “Create Circuits and VT 
Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-A278 Modify and Delete Overhead Circuits and Server 
Trails

Caution Deleting circuits can be service affecting and should be performed during a maintenance window.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 for a node on the network where you want 
to delete the circuit. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-A332 Change Tunnel Type” task on page 20-20.

Step 3 As needed, complete the “DLP-A336 Repair an IP Tunnel” task on page 20-24.

Step 4 As needed, complete the “DLP-A334 Delete Overhead Circuits” task on page 20-22.

Step 5 As needed, complete the “DLP-A453 Delete a Server Trail” task on page 21-33.

Stop. You have completed this procedure.

NTP-A78 Create a Monitor Circuit

Note Monitor circuits cannot be used with EtherSwitch circuits. 

Note For unidirectional circuits, create a drop to the port where the test equipment is attached.

Purpose This procedure changes the tunnel type, repairs IP circuits, and deletes 
overhead circuits and server trails.

Tools/Equipment None

Prerequisite Procedures Circuits must exist on the network. See Chapter 6, “Create Circuits and VT 
Tunnels.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a monitor circuit that monitors traffic on primary, 
bidirectional circuits. 

Tools/Equipment None

Prerequisite Procedures Bidirectional (two-way) circuits must exist on the network. See Chapter 6, 
“Create Circuits and VT Tunnels” for circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
7-5
Cisco ONS 15454 Procedure Guide, R8.5.x

78-18105-01



 

Chapter 7 Manage Circuits
NTP- A78 Create a Monitor Circuit
Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at a node on the network where you will 
create the monitor circuit. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Circuits tab.

Step 4 Choose the bidirectional (two-way) circuit that you want to monitor and click Edit.

Step 5 Verify that the circuit name is no longer than 44 characters. Monitor circuits append a “_MON” to the 
circuit name. If the name is longer than 44 characters, edit the name in the Name field, then click Apply.

Step 6 In the Edit Circuit window, click the Monitors tab.

The Monitors tab displays ports that you can use to monitor the circuit. 

Note The Monitors tab is only available when the circuit has a DISCOVERED status. 

Step 7 On the Monitors tab, choose the monitor source port. The monitor circuit will display traffic coming into 
the node at the port you choose. 

Note In Figure 7-1, you would choose either the DS1-14 card (to test circuit traffic entering Node 2 
on the DS1-14) or the OC-N card at Node 1 (to test circuit traffic entering Node 1 on the OC-N 
card).

Step 8 Click Create Monitor Circuit.

Step 9 In the Circuit Destination section of the Circuit Creation wizard, choose the destination node, slot, and 
port, and as applicable, STS, VT, and/or DS1 for the monitored circuit. 

Note In the Figure 7-1 example, the monitor circuit destination is Port 2 on the EC1-12 card. 

Step 10 Click Next.

Step 11 In the Circuit Routing Preferences area, review the monitor circuit information. If you want the monitor 
circuit routed on a bidirectional line switched ring (BLSR) protection channel, click 
Protection Channel Access. 

Step 12 Click Finish.

Step 13 In the Edit Circuit window, click Close. The new monitor circuit appears on the Circuits tab.

Figure 7-1 shows a sample monitor circuit setup. VT1.5 traffic is received by Port 1 of the EC1-12 card 
at Node 1. To monitor the VT1.5 traffic, test equipment is plugged into Port 2 of the EC1-12 card and a 
monitor circuit to Port 2 is provisioned in CTC. (Circuit monitors are one-way.) This example assumes 
that circuits have been created.
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Figure 7-1 VT1.5 Monitor Circuit Received at an EC1-12 Port

Stop. You have completed this procedure.

NTP-A328 Create a J0 Section Trace 

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at a node on the network where you will 
create the section trace. If you are already logged in, continue with Step 2.

Step 2 In node view, double-click the MRC-2.5G-4, MRC-12 or OC192-XFP card.

Step 3 Click the Provisioning > Line > Section Trace tabs.

Step 4 From the Port drop-down list, choose the port for the section trace.

Step 5 From the Trace Mode drop-down list, enable the section trace expected string by choosing Auto or 
Manual:

• Auto—The first string received from the source port is automatically provisioned as the current 
expected string. An alarm is raised when a string that differs from the baseline is received. 

• Manual—The string entered in the Current Expected String field is the baseline. An alarm is raised 
when a string that differs from the Current Expected String is received.

Step 6 In the Section Trace String Size area, click 1 byte, 16 byte, or 64 byte. In the New Transmit String field, 
enter the string that you want to transmit. Enter a string that makes the destination port easy to identify, 
such as the node IP address, node name, or another string. If the New Transmit String field is left blank, 
the J0 transmits a string of null characters.

Step 7 If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive 
from the source port in the New Expected String field. If you set Section Trace Mode to Auto, skip this 
step.
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OC-N DS1-14

XC
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Node 2

VT1.5 Drop

VT1.5 Monitor

Test Set

Port 1
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Switch
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Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to traffic between nodes. 

Tools/Equipment At least one of the following cards must be installed: MRC-2.5G-4, 
MRC-12 or OC192-XFP.

Prerequisite Procedures None

Required/As Needed As needed (optional if path trace is set)

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm 
indication signal (AIS) and remote defect indication (RDI) when the STS Section Trace Identifier 
Mismatch Path (TIM-P) alarm appears. Refer to the Cisco ONS 15454 Troubleshooting Guide for 
descriptions of alarms and conditions.

Step 9 Click Apply.

Step 10 After you set up the section trace, the received string appears in the Received field. The following 
options are available:

• Click Hex Mode to display section trace in hexadecimal format. The button name changes to 
ASCII Mode. Click it to return the section trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds if the Section Trace Mode field is set to 
Auto or Manual.

Stop. You have completed this procedure.

NTP-A79 Create a J1 Path Trace

Note You cannot create a J1 path trace on a TL1-like circuit.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at a node on the network where you will 
create the path trace. If you are already logged in, continue with Step 2.

Step 2 Complete the following tasks as needed: 

• As needed, complete the “DLP-A264 Provision a J1 Path Trace on Circuit Source and Destination 
Ports” task on page 19-44.

• As needed, complete the “DLP-A137 Provision Path Trace on OC-N Ports” task on page 18-15.

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to circuit traffic. 

Tools/Equipment ONS 15454 cards capable of transmitting and/or receiving path trace must 
be installed. See Table 19-3 on page 19-45 for a list of cards.

Prerequisite Procedures Path trace can only be provisioned on OC-N (STS) circuits. See Chapter 6, 
“Create Circuits and VT Tunnels” for OC-N circuit creation procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Stop. You have completed this procedure.

NTP-A293 Create a J2 Path Trace

Note You cannot create a J2 path trace on a TL1-like circuit.

Note This procedure assumes that you are setting up path trace on a bidirectional circuit and setting up 
transmit strings at the circuit source and destination.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at a node on the network where you will 
create the path trace. If you are already logged in, continue with Step 2. 

Step 2 From the View menu, choose Go to Network View. 

Step 3 Click the Circuits tab.

Step 4 For the VT circuit you want to monitor, verify that the source and destination ports are on a card that can 
transmit and receive the path trace string. 

Note If neither port is on a transmit/receive card, you will not be able to complete this procedure. If 
one port is on a transmit/receive card and the other is on a receive-only card, you can set up the 
transmit string at the transmit/receive port and the receive string at the receive-only port, but you 
will not be able to transmit in both directions.

Step 5 Choose the VT circuit you want to trace, then click Edit.

Step 6 In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A 
detailed map of the source and destination ports appears.

Step 7 Provision the circuit source transmit string:

a. On the detailed circuit map, right-click the circuit source port (the square on the left or right of the 
source node icon) and choose Edit J2 Path Trace (port) from the shortcut menu. 

b. In the New Transmit String field, enter the circuit source transmit string. Enter a string that makes 
the source port easy to identify, such as the node IP address, node name, circuit name, or another 
string. If the New Transmit String field is left blank, the J2 transmits a string of null characters.

c. Click Apply, then click Close.

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to circuit traffic. 

Tools/Equipment DS3XM-12 card or DS1/E1-56 card

Prerequisite Procedures See Chapter 6, “Create Circuits and VT Tunnels” for DS-3 circuit creation 
procedures.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Provision the circuit destination transmit string:

a. On the detailed circuit map, right-click the circuit destination port and choose Edit Path Trace from 
the shortcut menu.

b. In the New Transmit String field, enter the string that you want the circuit destination to transmit. 
Enter a string that makes the destination port easy to identify, such as the node IP address, node 
name, circuit name, or another string. If the New Transmit String field is left blank, the J2 transmits 
a string of null characters.

c. Click Apply.

Step 9 Provision the circuit destination expected string:

a. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual 
from the Path Trace Mode drop-down list:

• Auto—The first string received from the source port is automatically provisioned as the current 
expected string. An alarm is raised when a string that differs from the baseline is received. 

• Manual—The string entered in the Current Expected String field is the baseline. An alarm is 
raised when a string that differs from the Current Expected String is received.

b. If you set the Path Trace Mode field to Manual, enter the string that the circuit destination should 
receive from the circuit source in the New Expected String field. If you set Path Trace Mode to Auto, 
skip this step.

c. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check 
box if you want to suppress the AIS when a C2 mismatch occurs.

d. Click Apply, then click Close.

Note It is not necessary to set the format (16 or 64 bytes) for the circuit destination expected string; 
the path trace process automatically determines the format.

Step 10 Provision the circuit source expected string:

a. In the Edit Circuit window (with Show Detailed Map chosen), right-click the circuit source port and 
choose Edit Path Trace from the shortcut menu.

b. In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual 
from the Path Trace Mode drop-down list:

• Auto—Uses the first string received from the port at the other path trace end as the baseline 
string. An alarm is raised when a string that differs from the baseline is received.

• Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when 
a string that differs from the Current Expected String is received.

c. If you set the Path Trace Mode field to Manual, enter the string that the circuit source should receive 
from the circuit destination in the New Expected String field. If you set Path Trace Mode to Auto, 
skip this step.

d. (Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check 
box if you want to suppress the AIS when a C2 mismatch occurs.

e. Click Apply.

Note It is not necessary to set the format (16 or 64 bytes) for the circuit source expected string; the 
path trace process automatically determines the format.
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Step 11 After you set up the path trace, the received string appears in the Received field on the path trace setup 
window. The following options are available:

• Click Hex Mode to display path trace in hexadecimal format. The button name changes to 
ASCII Mode. Click it to return the path trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the path trace default settings (Path Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds if the Path Trace Mode field is set to Auto 
or Manual.

Step 12 Click Close.

The detailed circuit map indicates path trace with an M (manual path trace) or an A (automatic path 
trace) at the circuit source and destination ports. 

Stop. You have completed this procedure.

NTP-A334 Bridge and Roll Traffic

Purpose This procedure reroutes live traffic without interrupting service. You can 
use the Bridge and Roll wizard for maintenance functions such as card 
replacement or load balancing. A circuit consists of a source facility, 
destination facility(s), and intermediate facilities (path). 

Tools/Equipment None

Prerequisite Procedures • Circuits must exist on the network. See Chapter 6, “Create Circuits 
and VT Tunnels” for circuit creation procedures.

• To route circuits on protected ports, you must create a protection group 
using the “DLP-A73 Create a 1+1 Protection Group” task on 
page 17-77 or the “NTP-A126 Create a BLSR” procedure on 
page 5-12.

• When a roll involves two circuits, a data communications channel 
(DCC) connection must exist. See the “DLP-A377 Provision Section 
DCC Terminations” task on page 20-69.

• Use the “NTP-A329 Locate and View Circuits” procedure on page 7-2 
to verify that the planned Roll To paths are in service. Verify that the 
planned Roll To and Roll From paths are not in the Roll Pending status, 
used in test access, or used in a loopback. Refer to the 
Cisco ONS 15454 Troubleshooting Guide to clear any alarms. 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning and higher
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Note Using the bridge and roll feature, you can upgrade an unprotected circuit to a fully protected circuit or 
downgrade a fully protected circuit to an unprotected circuit.

Caution Performing bridge and roll on an STS192C might cause a traffic hit up to and including 50 ms.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at the ONS 15454 circuit source node. If 
you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-A463 Roll the Source or Destination of One Optical Circuit” task on 
page 21-44.

Step 3 As needed, complete the “DLP-A464 Roll One Cross-Connect from an Optical Circuit to a Second 
Optical Circuit” task on page 21-46.

Step 4 As needed, complete the “DLP-A465 Roll Two Cross-Connects on One Optical Circuit Using Automatic 
Routing” task on page 21-48 or the “DLP-A466 Roll Two Cross-Connects on One Optical Circuit Using 
Manual Routing” task on page 21-52.

Step 5 As needed, complete the “DLP-A467 Roll Two Cross-Connects from One Optical Circuit to a Second 
Optical Circuit” task on page 21-54.

Step 6 As needed, complete the “DLP-A489 Cancel a Roll” task on page 21-60.

Step 7 As needed, complete the “DLP-A468 Delete a Roll” task on page 21-56. Use caution when selecting this 
option. Delete a roll only if it cannot be completed or canceled. Circuits might have a PARTIAL status 
when this option is selected.

Stop. You have completed this procedure.

NTP-A298 Reconfigure Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61. If you are already logged in, continue with 
Step 2.

Step 2 Click the Circuits tab. 

Step 3 Highlight the circuits that you want to reconfigure.

Step 4 From the Tools menu, choose Circuits > Reconfigure Circuits.

Step 5 In the confirmation dialog box, click Yes to continue.

Purpose This procedure rebuilds circuits, which might be necessary when a large 
number of circuits are in the PARTIAL status.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 In the notification box, view the reconfiguration result. Click Ok.

Stop. You have completed this procedure.

NTP-A301 Merge Circuits

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61. If you are already logged in, continue with 
Step 2.

Step 2 Click the Circuits tab. 

Step 3 Click the circuit that you want to use as the master circuit for a merge.

Step 4 Click Edit.

Step 5 In the Edit Circuits window, click the Merge tab.

Step 6 Choose the circuits that you want to merge with the master circuit.

Step 7 Click Merge.

Step 8 In the confirmation dialog box, click Yes to continue.

Step 9 In the notification box, view the merge result. Click Ok.

Stop. You have completed this procedure.

NTP-A325 Manage VLANs

Purpose This procedure merges two circuits that create a single, contiguous path but 
are separate circuits because of different circuit IDs or conflicting 
parameters. A merge combines a single master circuit with one or more 
circuits. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure allows you to view, create, or delete VLANs.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note Remove all unused VLANs. The recommended number of VLANs is a maximum of 100; if more than 
100 VLANs exist, the E-Series cards may have problems accepting new VLANs.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61. If you are already logged in, continue with 
Step 2.

Step 2 From the Tools menu, choose Manage VLANs. The All VLANS dialog box appears listing all of the 
VLAN topologies in the network.

Step 3 Complete the following as necessary:

• To add a VLAN, complete the “DLP-A452 Create a VLAN” task on page 21-32.

• To delete a VLAN, complete the “DLP-A335 Delete VLANs” task on page 20-23.

Stop. You have completed this procedure.

NTP-A348 Display IEEE 802.17 RPR Circuits

Note CTC does not support the display of Cisco proprietary RPR circuit topology.

Note CTC does not support provisioning or maintenance of IEEE RPR rings. You must use Cisco IOS.

Step 1 Complete the “DLP-A60 Log into CTC” task on page 17-61 at the node where you will view the circuit. 
If you are already logged in, continue with Step 2.

Step 2 From network, shelf, or ML-Series card view, click the Circuits tab and select the circuit where you want 
to display information. 

Note If you are viewing the circuits list from network or shelf view, you must look at the Source and 
Destination fields to determine which circuits are RPR circuits.

Step 3 Click Tools > Circuits > Show RPR Circuit Ring.

Purpose This procedure displays a map of and provides information about IEEE 
802.17 Resilient Packet Ring (RPR) circuits between ML-Series cards. For 
more information about IEEE 802.17 RPR, refer to the Cisco ONS 15454 
and Cisco ONS 15454 SDH Ethernet Card Software Feature and 
Configuration Guide.

Tools/Equipment None

Prerequisite Procedures DLP-A556 Provision the Card Mode for ML-Series Ethernet Cards, 
page 22-67

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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The map displays the following information about each IEEE 802.17 RPR circuit:

• Circuit name

• Type

• Size

• OCHNC Wlen

• Direction

• Protection

• Status

• Source

• Destination

• # of VLANs

• # of Spans

• State

• Loopback

Step 4 Repeat this procedure as necessary for additional 802.17 RPR circuits you want to display.

Stop. You have completed this procedure.
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